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Introduzione al software KNIME Analytics Platform

▪ KNIME

 KNIME (Konstanz Information Miner) è una piattaforma open-source 

sviluppata da Knime AG (http://www.knime.org) per l’analisi dei dati 

attraverso un’interfaccia grafica che permette all’utente di compiere l’intero 

processo di analisi, dall’accesso ai dati all'applicazione dei risultati.

 L’interfaccia grafica, attraverso un diagramma di flusso, permette 

l’assemblaggio dei nodi per il pre-processing dei dati, l’analisi, il 

modeling, la visualizzazione dei risultati e il reporting. 

 KNIME® Analytics Platform supporta una vasta gamma di strumenti 

analitici da quelli statistici e di machine learning al text processing. 
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Introduzione al software KNIME Analytics Platform

▪ La piattaforma applicativa OPEN-SOURCE 
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Introduzione al software KNIME Analytics Platform

Vista d’insieme

Guida del nodo

Workflow

▪ L’Interfaccia grafica 
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Introduzione al software KNIME Analytics Platform

Sezione 
dei nodi

Node Repository

Registro degli eventi

▪ L’Interfaccia grafica  
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▪ Il Workspace 

 È il luogo fisico (root directory) dove stanno i diagrammi di flusso (Workflow) 

• Ci possono essere

  più Workspace

• Ogni Workspace può

  contenere più cartelle e 

  sottocartelle (Group)

• Ogni cartella o sottocartella

  può contenere più Workflow

Introduzione al software KNIME Analytics Platform

Workspace

WorkflowSottocartella /Group

Cartella / Group
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Introduzione al software KNIME Analytics Platform

▪ Il Workspace 

•  Nel Workspace remoto di KNIME

  EXAMPLES 

  e nel Workspace d'installazione 

  LOCAL

  sono contenuti molti esempi 

  di utilizzo. 
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▪ Il Workspace

 Gli EXAMPLES sul server remoto sono documentati nella guida online: 

https://www.knime.com/nodeguide
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Ambiente operativo

https://www.knime.com/blog/the-node-guide-finding-help-in-knime-analytics-platform-and-on-the-web


▪ Il Workspace

 Dalla versione 4.0 è stata aggiunta nel
 Workspace la possibilità di trovare e 
 condividere workflow, nodi e soluzioni

applicative. 

Facendo doppio clic 
 su Private o Public si 
 apre una pagina dove 
 si può accedere a 
 queste funzionalità.  
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Introduzione al software KNIME Analytics Platform

▪ Il Workspace 

 Ci possono essere diversi Workspace. KNIME, alla partenza, chiede quale aprire.

 Un Workspace può essere cambiato all’interno di una sessione (KNIME viene chiuso 

e riaperto)
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▪ Il Workflow

 KNIME utilizza la programmazione visuale. 

 Questo comporta che ogni passo di analisi viene rappresentato in un editor grafico 

attraverso un’icona chiamata Nodo.

 Il Workflow è una sequenza di nodi connessi che vengono aggiunti “trascinandoli“ 

dalla sezione dei nodi e “rilasciati“ sulla finestra dell’editor. 

Workflow
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Introduzione al software KNIME Analytics Platform

▪ Il Workflow

Il Workflow, una volta salvato, compare nel KNIME Explorer.  
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▪ I Nodi

 

 I Nodi sono connessi tra di loro attraverso le loro porte di input e di output: basta solo 

‘cliccare’ sulla porta di uscita del nodo precedente e rilasciare sulla porta di ingresso 

di quello successivo.

 

 I nodi hanno 3 possibili stati rappresentati da colori semaforici:

• Rosso: Presenza di errori in esecuzione o non ancora configurato

• Giallo: Configurato ma non eseguito  

• Verde: Eseguito con successo

 

 Ogni nodo può essere configurato ed eseguito con gli 

 appositi comandi ottenuti con il tasto destro del mouse.  
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▪ I Nodi

 

 La configurazione avviene per mezzo di apposite schede (3 o più):

 

• La prima e, se presenti, altre 

  schede contenenti le impostazioni 

  per l’esecuzione del nodo 

  

• Quella per la gestione delle Flow 

  Variables

• Quella per la gestione della memoria 

  (vedi appendice)
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▪ I Nodi

 

 I Nodi possono avere molte porte.

• Porte di Input e di Output dei dati

 Servono al passaggio dei dati 

• Porte di Input e di Output del modello

  Servono al passaggio dei coefficienti 

  e delle statistiche dei modelli

• Porte delle Flow Variables

 Servono per rendere parametrici i 

  Workflow, i nodi vengono impostati

  dinamicamente.

• Porte delle connessioni ai Database

 Servono per l'accesso di database

  esterni.

• Porte di output delle immagini 
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▪ Le estensioni
 

 Le estensioni open-source forniscono funzionalità aggiuntive (attraverso nodi 

specifici) come l'accesso e l'elaborazione di dati complessi, nonché l'aggiunta di 

algoritmi avanzati di apprendimento automatico.
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▪ Metanodi

 Raggruppamento di nodi (Collapse into a Metanode)

• Si possono raggruppare insieme dei nodi all’interno di un Metanodo 

 una volta selezionati con il bottone destro del mouse scegliendo l’opzione 

  Collapse into Meta Node.
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Introduzione al software KNIME Analytics Platform

▪ Tabella in formato KNIME

 

Nodo Table Creator

 Crea una tabella in formato KNIME 

 definendo le colonne e inserendo 

 direttamente i valori.

Nodo Table Reader

Legge una tabella in 

formato KNIME.

21

Accesso ai dati



Introduzione al software KNIME Analytics Platform

▪ Tabella in formato KNIME

 

 Tipologie di dati più comuni.

 

• Integer/Double

✓I   - Interi

✓D - Doppia precisione

• String

✓S - Testo

• Date/Time

✓   - Data 

✓       - Data/Orario

N.B. I dati mancanti vengono rappresentati con il punto interrogativo "?". 
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Introduzione al software KNIME Analytics Platform

▪ File di testo generici

 

 Nodo File Reader

  

Nomi delle colonne nella prima riga

Percorso del file

Delimitatore

Prima colonna come Row ID

Attributi colonna
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Introduzione al software KNIME Analytics Platform

▪ File di testo delimitati 

 

 Nodo CSV Reader

 Legge file esterni in formato csv
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Percorso del file

Carattere di delimitazione 
delle colonne

Delimitatore di riga

Nomi delle colonne nella prima riga

Prima colonna come Row ID

Sta in una sottocartella 
del Workspace



Introduzione al software KNIME Analytics Platform

▪ File Excel 

 

 Nodo Excel Reader

 Legge file in formato Excel 

 (.xls, .xlsx) 
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Percorso del file

Nome del foglio

Nomi delle colonne nella riga 1

Lettura di un range

Sta nella stessa cartella 
del workflow



Introduzione al software KNIME Analytics Platform

▪ Input Location (CSV e Excel) – 1/2

 

 Il file sta in un percorso preciso,  

 è dipendente dal sistema operativo

 <workspace>/folder1/folder2/file.ext

 Il file sta in una sotto-cartella 

 dell'attuale Workspace

 <workspace>/folder1/folder2/file.ext

 Il file sta nella stessa cartella

 dell'attuale workflow

 <workspace>/cartella1/cartella2/file.ext
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Introduzione al software KNIME Analytics Platform

▪ Input Location (CSV e Excel) – 2/2

 

 Vengono letti più file nella stessa 

 cartella

 Si possono selezionare per nomi 

 ed estensioni 

 Il file sta in un URL (indirizzo di una 

 risorsa su una rete di computer)

 Per approfondimenti: https://docs.knime.com/2021-06/analytics_platform_file_handling_guide/index.html#introduction
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Introduzione al software KNIME Analytics Platform

▪ Database Relazionali – 1/3

 

 Nodo Database Connector

Crea una connessione con qualsiasi 

 database attraverso l’apposito driver

 JDBC supportato da KNIME.

 - MS SQL Server

 - Oracle

 

 - DB2

 - …
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Introduzione al software KNIME Analytics Platform

▪ Database Relazionali – 2/3

 

 Ci sono altri nodi specifici per la 

 connessione al database che si 

 sta utilizzando.

 Bisogna solo fornire l’indirizzo del 

 database e le proprie credenziali,

 se richieste.

✓ Nodo Microsoft Access Connector

✓ Nodo MySQL Connector

✓ Nodo SQLite Connector 

29

Accesso ai dati



Introduzione al software KNIME Analytics Platform

▪ Database Relazionali – 3/3

 

 Nodo Database Reader

 È un nodo generico di accesso e di

 lettura al database specificato.

 

 Nodo Database Writer

 È un nodo generico di accesso e di

 scrittura al database specificato.
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Introduzione al software KNIME Analytics Platform

▪ DataBase Relazionali – 3/3 (cont.)

 

 Nodo Database Reader/Writer

 Se già presente un nodo dedicato,

 prende da questo le informazioni 

 per la connessione.
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Introduzione al software KNIME Analytics Platform

▪ Big Data Extensions1

 

✓ Spark

✓ HDFS 

✓ Hive

✓ Impala

✓ …

1
 Necessitano di licenza commerciale.
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Introduzione al software KNIME Analytics Platform

▪ Esportazione

 

Nodo Table Writer

Scrive una tabella in formato KNIME.

 Nodo CSV Writer

 Crea un file esterno di tipo tabellare dove le colonne sono separate da un 

delimitatore.

 Nodo Excel Writer

 Può essere scritto sia nel formato Excel 2003 (.xls), sia nel formato Excel 2007 

(.xlsx).

 Nodo PMML

 Crea un file in formato PMML (Predictive Model Markup Language) per la 

condivisione di modelli con altri software.
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▪ Ordinamento (Sort)

 

 Nodo Sorter

 Ordinamento per una o più colonne   

▪ Unione

 Nodo Concatenate 

 Aggiunge le righe di una seconda 

 tabella alla prima (tutte le colonne

 o solo quelle comuni)
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▪ Combinazione di 2 tabelle – 1/3

 

 Nodo Joiner

• Le colonne da utilizzare per la combinazione
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IMPORTANTE!
In mancanza della corrispondenza con la 
colonna di sinistra, il valore la colonna risultante 
prende quello della colonna di destra, evitando 
così di ottenere un valore mancante.



▪ Combinazione di 2 tabelle – 2/3

 

 Le modalità 

  

• Inner join

• Left join

• Right join

• Full join
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▪ Combinazione di 2 tabelle – 3/3

 

 Le colonne da tenere
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Suffisso se le colonne 
hanno gli stessi nomi
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Introduzione al software KNIME Analytics Platform

▪ Selezione righe (semplice) – 1/3

 

 Nodo Row Filter

• Seleziona in base a una 

particolare sequenza di

valori (pattern matching)
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Introduzione al software KNIME Analytics Platform

▪ Selezione righe (semplice) – 1/3 (cont.)

 

 Nodo Row Filter

• Seleziona in base a una 

particolare sequenza di

valori (pattern matching)

• Seleziona per un intervallo 

  di valori (range checking)
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Introduzione al software KNIME Analytics Platform

▪ Selezione righe (avanzata) – 2/3

 

 Nodo Rule-Based Row Filter

• Operatori relazionali

  > , < , >= , <= , 

  MATCHES (RegEX),

  LIKE,

  FALSE, MISSING

• Operatori logici

  OR, AND, XOR
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Introduzione al software KNIME Analytics Platform

▪ Selezione righe (avanzata) – 3/3 

 

 Nodo Rule-Based Row Splitter

• Operatori relazionali

  > , < , >= , <= , 

  MATCHES (RegEX),

  LIKE,

  FALSE, MISSING

• Operatori logici

  OR, AND, XOR

first output table

second output table
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Introduzione al software KNIME Analytics Platform

▪ Selezione colonne

 

 Nodo Column Filter

 

• Si indicano le colonne

 da mantenere in uscita
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Introduzione al software KNIME Analytics Platform

▪ Cambiamento del nome e/o del tipo colonna

  

 Nodo Rename 

• Cambia il nome della colonna

• Cambia il tipo della colonna

N.B. Non tutti i cambiamenti di tipo 

colonne sono ammessi!
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Introduzione al software KNIME Analytics Platform

▪ Cambiamento del tipo colonna1 – 1/2

  

 Nodo Number to String

 Converte colonne numero in colonne stringa

 

 Nodo String to Number

 Converte colonne stringa in colonne numero

 

 Nodo Double to Int

 Converte colonne numero doppia precisione 

 in colonne numero intero

1
 Quelli che non sono ammessi nel nodo Rename.
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Introduzione al software KNIME Analytics Platform

▪ Cambiamento del tipo colonna – 2/2

 

 Nodo String to Date/Time 

 Converte colonne stringa in colonne data/orario1.  

 

• Qualora non fosse presente, bisogna

 digitare il formato esatto della data.

1
 Fare attenzione nel fornire il giusto formato data/orario della colonna utilizzata!
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Introduzione al software KNIME Analytics Platform

▪ Creazione colonne con valori precedenti 

 

 Nodo Lag column 

 Serve per costruire una o più colonne prendendo i valori precedenti (lag) di una 

colonna di riferimento in base all'intervallo specificato.

• Colonna di riferimento

• Numero di colonne 

• Intervallo 
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Table Lookup) 

 

 Nodo Cell Replacer

 Sostituisce i valori di una colonna con 

 i valori presi da una tabella di lookup.
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Regole, Espressioni, Funzioni) – 2/5

 

 Nodo Math Formula

 Crea o sostituisce i 

 valori di una colonna 

 con espressioni 

 aritmetiche o funzioni. 

 A lato un esempio di 

 calcolo della media dei 

 3 test.
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Regole, Espressioni, Funzioni) – 3/5 

 

 Nodo Math Formula (Multi Colum)

 Crea o sostituisce i 

 valori di più colonne 

 con espressioni 

 aritmetiche o funzioni. 

 A lato un esempio di 

 calcolo dello z-score per

 ogni test.
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Regole, Espressioni, Funzioni) – 4/5  

 

 Nodo Column Expressions

 Crea o sostituisce i 

 valori di più colonne 

 con espressioni 

 aritmetiche o funzioni. 

 Si possono usare

 strutture di controllo1

 come il costrutto

 if … else …
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1
 Devono, per sintassi, essere conformi a quelli dello JavaScript.
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Regole, Espressioni, Funzioni) – 5/5

 

 Nodo Java Snippet

 

 Crea o sostituisce i 

 valori di una colonna 

 con espressioni 

 aritmetiche o funzioni. 

 A lato esempi di 

 espressioni aritmetiche.

 Nella codifica bisogna

 fare uso di campi Java

 sia per l'input (c_ …) 

 sia per l'output (out_ …).
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Funzioni sulle stringhe) – 1/2

 

 Nodo String Manipulation

• strip toglie spazi inizio e fine

• replace sostituisce stringhe

• compare confronta stringhe (<,=,>; -1,0,1)

• count conta occorrenze sottostringa

• indexOf puntatore sottostringa1

• substr estrattore stringa2

• join unisce stringhe

• length lunghezza stringa

• toInt da stringa a numero

• string da numero a stringa

• joinSep unisce stringhe con separatore

• regexMatcher confronta stringhe con RegEx

• regexReplace sostituisce stringhe con RegEx 

• upperCase maiuscolo

• lowerCase minuscolo

• capitalize iniziale maiuscola

55

1
 Il valore va da 0 (se il primo carattere) alla lunghezza della stringa meno 1. 

2
 Estrae sottostringhe dal puntatore per n caratteri, Il puntatore del primo carattere ha valore 0. 
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Introduzione al software KNIME Analytics Platform

▪ Creazione/Modifica valori (Funzioni sulle stringhe) – 2/2

 

 Nodo String Manipulation 

 Esempi
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Campo1 Campo2 Funzione Trasformazione

M.Rossi@dominio.tld replace($campo1$,"tld","it") "M.Rossi@dominio.it"

M.Rossi@dominio.it substr($campo1$,8) "dominio.it"

M.Rossi@dominio.it IndexOf($campo1$,"@") 8

Rossi, Mario substr($campo1$,0,indexOf($campo1$,",")) "Rossi"

Rossi, Mario substr($campo1$,indexOf($campo1$,",")+2) "Mario"

Rossi Mario joinSep("_",$campo2$,$campo1$) "Mario_Rossi"

(+39) 345-1234567 replaceChars($campo1$,"()- ","") "+393451234567"

39 40 compare($campo1$,$campo2$) -1 

40 40 compare($campo1$,$campo2$) 0 

41 40 compare($campo1$,$campo2$) 1

RSSMRA30A01H501I regexMatcher($campo1$,"[A-Z]{6}[0-9]{2}[A-Z][0-9]{2}[A-Z][0-9]{3}[A-Z]")"True"

RSSMRA30A01H501I toInt(substr($campo1$,6,2))+1900 1930

Trasformazione



▪ Trasposizione righe/colonne – 1/3

 

 Nodo Transpose

 Scambia le righe con le colonne.
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▪ Trasposizione righe/colonne – 2/3

 

 Nodi Unpivoting 

 Si indicano la/e colonne (Value columns) i cui nomi vengono riportati nella colonna 

ColumnNames e i loro valori nella colonna ColumnValues, mantenendo la struttura della 

colonna indicata come "perno" (Retained column).

Introduzione al software KNIME Analytics Platform

Value columns

 test1

 test2

 final

Retained columns

 Student
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▪ Trasposizione righe/colonne – 3/3

 

 Nodi Pivoting

 Si indicano la/e colonne di raggruppamento (Group column(s)) e la/e colonne (Pivot 

column(s)) dai valori delle quali vengono create le nuove colonne i cui valori vengono 

presi da un'altra colonna (Manual Aggregation) secondo la/e funzioni di aggregazione 

scelte come somma, conteggio, media, deviazione standard, min, max, …

Introduzione al software KNIME Analytics Platform

Group column(s) Pivot columns Manual Aggregation

 ColumnNames Student     ColumnValues (sum) 
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▪ Raggruppamento/Sommarizzazione – 1/2

 

 Nodo GroupBy

 Nella scheda Groups si selezionano le colonne di raggruppamento
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▪ Raggruppamento/Sommarizzazione – 2/2

 

 Nodo GroupBy

 Nella scheda Manual Aggregation si scelgono le colonne sulle quali applicare le 

funzioni di aggregazione (somma, conteggio, media, dev. standard, min, max, …).
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▪ Valori mancanti – 1/2

 

 Nodo Missing Value

 Con questo nodo è possibile 

 sostituire i valori mancanti 

 (caratteri o numeri) con 

 uno dei metodi disponibili: 

• Interpolazione media

• Interpolazione lineare

• Media mobile 

• Media

• Mediana

• Moda

• Massimo

• Minimo

• …
 

 oppure 

 eliminare le righe che li 

 contengono.
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▪ Valori mancanti – 2/2

 

 Nodo Missing Value Column Filter

 

 Rimuove le colonne selezionate che contengono valori mancanti oltre una certa 

percentuale.
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▪ Normalizzazione

 Nodo Normalizer

 Normalizza i dati numerici 

 con le impostazioni:

 - Min/Max, 

 - Z-Score, 

 - Decimal Scaling

 

 Nodo Denormalizer

 Per ottenere i valori originali
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▪ Valori Estremi (Outlier) – 1/2

 Nodo Numeric Outliers

 

 Per individuare i valori 

 estremi con il Range 

 Interquartile (IQR) e 

 scegliere se: 

 - sostituirli con valori 

  mancanti

 - eliminare le righe 

  che li contengono
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▪ Valori Estremi (Outlier) – 2/2

 

 Nodo Normalizer e Column Expression
 

 La flessibilità del nodo Column Expression 

 permette di impostare dei propri valori limite 

 in base alla variabile standardizzata Z.

   

Z-Score       Intervallo di confidenza Errori x 1Mio

 1,64485 → 90%   50.000

 1,95996  → 95%   25.000

 2,5 → 98,7581% (4 Sigma s.t.)   6.210

 2,57583 → 99%     5.000

 2,69795 → 99,3023% (1,5*IQR)    3.488 

 4,5 → 99,9993% (6 Sigma s.t.)       3,4
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▪ Partizionamento – 1/2

 

 Nodo Auto-Binner

 I dati vengono partizionati in bins (gruppi) che possono essere di
 

• uguale ampiezza1   
   

• uguale frequenza2
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1
 Sconsigliato in quanto può produrre distribuzioni molto sbilanciate.

2  
Potrebbe non essere possibile ottenere la stessa frequenza a causa di valori ripetuti.



▪ Partizionamento – 2/2 

 

 Nodo Numeric-Binner

 I dati vengono partizionati in bins (gruppi) che possono essere personalizzati. 
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Introduzione al software KNIME Analytics Platform

▪ Flow Variables (opzionale)   

 

 Si presenta talvolta la necessità di voler cambiare dinamicamente le impostazioni dei 

nodi durante l'esecuzione del Workflow. Questo si può fare attraverso l'utilizzo delle 

variabili di flusso, le Flow Variables.

 

 Queste funzionalità vengono applicate ai nodi con delle porte dedicate e identificate 

all'interno dei nodi nella relativa scheda. 
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Introduzione al software KNIME Analytics Platform

▪ Flow Variables (opzionale) – 1/2  

 

 Nodo Single Selection

 In questo esempio vengono impostati, nel nodo Single Selection, i possibili valori 

che potrà assumere la Flow Variable "lingua". Nel nodo Row Filter, invece che 

un valore predefinito per selezionare la colonna (column2), si imposta la Flow 

Variable che lo conterrà.
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Introduzione al software KNIME Analytics Platform

▪ Flow Variables (opzionale) – 2/2 

 

 Nodo Single Selection

 Quando viene eseguito il nodo Single Selection, si apre un modulo (quickform) dove 

si può selezionare il valore desiderato, che sarà quello utilizzato per filtrare le righe 

della colonna indicata nel nodo Row Filter (column2).
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▪ Evidenziare parti selezionate (Highlighting) 

 

 Quando si lavora su dati visualizzati su più finestre, può essere utile poterli 

selezionare su una vista e vederne i collegamenti su tutte le altre in modo dinamico.

 Si selezionano prima dalla tabella o dal grafico i dati da collegare e poi dal menu 

dei risultati si sceglie Hilite → Hilite Selected  
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Introduzione al software KNIME Analytics Platform

▪ Funzionalità

 Nodi di visualizzazione
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Introduzione al software KNIME Analytics Platform

▪ Utility/Diagrammi

 Nodo Color Manager

 assegna un colore ad ogni valore di colonna
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Introduzione al software KNIME Analytics Platform

▪ Istogrammi 

 

 Nodo Histogram + Image Writer (Port)

• Image Writer (Port): SVG

 Nodo Histogram Chart (JFreeChart) + Image Writer(Port)

• General Plot Options -> Type of Image: PNG, SVG

 Nodo Interactive Histogram (local)

• File -> Export as -> PNG, SVG
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Introduzione al software KNIME Analytics Platform

▪ Diagrammi a barre 

 

 Nodo Bar Chart + Image Writer (Port)

• Image Writer (Port): SVG

 Nodo Bar Chart (JFreeChart) + Image Writer(Port)

• General Plot Options -> Type of Image: PNG, SVG

 Nodo GroupBy + 

 GroupBy Bar Chart (JFreeChart) + Image Writer(Port)

• General Plot Options -> Type of Image: PNG, SVG
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Introduzione al software KNIME Analytics Platform

▪ Diagrammi circolari1 (grafici a torta) 

 

 Nodo Pie/Donut + Image Writer (Port)

• Image Writer (Port): SVG

 Nodo Pie Chart (JFreeChart) + Image Writer(Port)

• General Plot Options -> Type of Image: PNG, SVG

 

 Nodo Interactive Pie (local)

• File -> Export as -> (PNG, SVG)
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 Solo per colonne di tipo carattere.
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Introduzione al software KNIME Analytics Platform

▪ Grafici di dispersione1 

 

 Nodo Scatter Plot + Image Writer (Port)

• Image Writer (Port): SVG

 Nodo Scatter Plot (JFreeChart) + Image Writer(Port)

• General Plot Options -> Type of Image: PNG, SVG

 Nodo Scatter Plot (local)

• File -> Export as -> PNG, SVG

 

 

 
81

1
 Solo per colonne di tipo numerico.
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Introduzione al software KNIME Analytics Platform

▪ Matrice di dispersione 

 

 Nodo Scatter Matrix (local)

• File -> Export as -> (PNG, SVG)
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Introduzione al software KNIME Analytics Platform

▪ Grafici a linee 

 

 Nodo Line Plot + Image Writer (Port)

• Image Writer (Port): SVG
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Introduzione al software KNIME Analytics Platform

▪ Diagrammi a scatola (e baffi) 

 

 Nodo Conditional Box Plot + Image Writer (Port)

• Image Writer (Port): SVG

 

 Nodo Box Plot (local)

• File -> Export as -> PNG, SVG
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Introduzione al software KNIME Analytics Platform

▪ Utility/Diagrammi

 Nodo Image Writer (Port)

 esporta il grafico nel formato del nodo che lo precede (PNG o SVG)
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Introduzione al software KNIME Analytics Platform

▪ Impaginare più grafici  

 

 Nodo Component

 Con questo nodo è possibile "incapsulare" 

 più grafici insieme e visualizzarli attraverso 

 una griglia personalizzata. 

 

 Lo si apre e lo si configura
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Introduzione al software KNIME Analytics Platform

▪ Impaginare più grafici – 1/2 

 

 Nodo Component

 Con questo nodo è 

 possibile unire insieme

 più grafici e visualizzarli 

 attraverso una griglia 

 predefinita. 
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Introduzione al software KNIME Analytics Platform

▪ Impaginare più grafici – 2/2 

 

 Una volta aperto lo si configura:

Per approfondimenti:

https://docs.knime.com/2020-07/analytics_platform_components_guide/index.html#widget-nodes
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Introduzione al software KNIME Analytics Platform

▪ Statistiche descrittive per raggruppamenti

 Nodo GroupBy 

 Le statistiche descrittive, 

 come già visto in precedenza,

 si possono ottenere anche 

 per aggregazioni di valori

 di altre colonne.
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Introduzione al software KNIME Analytics Platform

▪ Calcolo Quantili 

 Nodo GroupBy  

 Con i quantili si possono calcolare qualsiasi divisione della popolazione in n parti di 

uguale frequenza (per esempio i quartili, quintili, decili, percentili, …). In particolare:
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quantile quartile quintile decile percentile

0 0 0 0 0 minimo

0,025

0,10 1 10

0,20 1 2 20

0,25 1 25 Q1

0,4 2 4 40

0,5 2 5 50 mediana

0,6 3 6 60

0,75 3 75 Q3

0,8 4 8 80

0,9 9 90

1 4 5 10 100 massimo



Introduzione al software KNIME Analytics Platform

▪ Calcolo Quantili 

 Nodo GroupBy

 Per il calcolo dei quantili ci sono ben 9 metodi1. Si possono selezionare da 

Edit → Aggregation Settings → Advanced.
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1
 https://en.wikipedia.org/wiki/Quantile#Estimating_quantiles_from_a_sample 

https://en.wikipedia.org/wiki/Quantile#Estimating_quantiles_from_a_sample


Introduzione al software KNIME Analytics Platform

▪ Esplorazione – 1/2

 Nodo Data Explorer

 Visualizza le statistiche descrittive di una tabella Knime delle colonne d'interesse.
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Introduzione al software KNIME Analytics Platform

▪ Esplorazione – 2/2

 Nodo Data Explorer 

 Le colonne indicate come escluse non vengono portate in uscita.
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Introduzione al software KNIME Analytics Platform

▪ Statistiche descrittive

 Nodo Statistics 

• Histogram -> Histogram format: PNG, SVG
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Introduzione al software KNIME Analytics Platform

▪ Statistiche descrittive

 Nodo Crosstab 

• Histogram -> Histogram format: PNG, SVG
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Introduzione al software KNIME Analytics Platform

▪ Correlazione lineare – 1/2

 Nodo Linear Correlation
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Introduzione al software KNIME Analytics Platform

▪ Correlazione lineare – 2/2

 Nodo Correlation Filter

 Rimuove la/e colonne ridondanti che sono sopra un valore di soglia di correlazione.

 In questo esempio, la colonna

 peso non viene portata in uscita 

 in quanto correlata positivamente

 con la colonna altezza (r=0,88) e

 superiore al valore di soglia.
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Introduzione al software KNIME Analytics Platform

▪ Regressione lineare

 Nodi Linear Regression Learner e Linear Regression Predictor

 Calcola una regressione lineare multipla.
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▪ Campionamento

 Nodo Row Sampling 

 Si può fare prendendo n righe o la loro percentuale, in modo casuale o stratificato. 
 

 Con il campionamento stratificato la distribuzione dei valori della colonna 

selezionata è (approssimativamente) mantenuta nella tabella di uscita. 

 Se si vogliono ottenere sempre le stesse tabelle in uscita, si può usare un seme 

casuale.
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Introduzione al software KNIME Analytics Platform

▪ Partizionamento 

 Nodo Partitioning

 Suddivide la tabella di input in 2 

 sottoinsiemi (il training set e il test set).   

103

Training set

Test set

Machine Learning



Introduzione al software KNIME Analytics Platform

▪ Regressione Logistica – 1/3

 Nodi Logistic Regression Learner e Logistic Regression Predictor 

 Esempio: studio farmaco per nevralgia
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Introduzione al software KNIME Analytics Platform

▪ Regressione Logistica – 2/3

 Nodi Logistic Regression Learner e Logistic Regression Predictor  
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Introduzione al software KNIME Analytics Platform

▪ Regressione Logistica/Matrice di confusione – 3/3

 Nodo Scorer (Java Script)  
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Introduzione al software KNIME Analytics Platform

▪ Albero di decisione – 1/3

 Nodi Decision Tree Learner e 

 Decision Tree Predictor

 Esempio: giocare a tennis 
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Introduzione al software KNIME Analytics Platform

▪ Albero di decisione – 2/3

 Nodi Decision Tree Learner e 

 Decision Tree Predictor 
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Introduzione al software KNIME Analytics Platform

▪ Albero di decisione – 3/3

 Nodi Decision Tree Learner e 

 Decision Tree Predictor 
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▪ Validazione modelli – Curva ROC

 

 Indicando per ogni nodo Predictor un apposito suffisso è possibile confrontare 

insieme diversi modelli:
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Introduzione al software KNIME Analytics Platform

▪ Cluster Analysis (gerarchica) – 1/2  

 Nodo Hierarchical Clustering 

 Esempio: segmentare clienti banca per prodotti posseduti
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ID

Cliente

Conti

Correnti
Libretti Mutui

Prestiti

Personali

Altri

Prestiti
Obbligazioni Fondi

Certificati

Deposito

1 1 1 0 0 0 2 0 0

2 1 1 0 0 0 0 1 0

3 1 0 1 1 1 1 1 0

4 1 0 1 1 0 0 0 0

5 1 0 0 1 0 0 0 0

6 0 0 1 0 1 0 0 0

7 0 1 0 0 0 0 0 0

8 1 0 0 0 0 1 1 0

9 0 0 0 1 0 0 0 1

10 1 0 0 0 0 1 0 0

11 1 0 0 0 0 1 1 0

12 1 0 1 1 0 0 0 0

13 1 0 1 1 0 0 0 0

14 1 1 0 0 0 0 1 0

15 0 1 0 0 0 0 0 0

16 0 0 1 0 1 0 0 0

17 0 0 0 0 0 1 0 0

18 0 1 0 1 0 0 0 0

19 1 1 0 0 0 1 0 1 (segue)



Introduzione al software KNIME Analytics Platform

▪ Cluster Analysis (gerarchica) – 2/2  

 Nodo Hierarchical Clustering 

 - Il Cluster A, “Risparmiatori Tradizionali”. È caratterizzato da libretti, obbligazioni e fondi.

 - Il Cluster B, "Indebitati". È caratterizzato da mutui e prestiti.

 - Il Cluster C, “Investitori”. È caratterizzato in gran parte da fondi e obbligazioni.
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Introduzione al software KNIME Analytics Platform

▪ Cluster Analysis (non gerarchica) – 1/2  

 Nodo k-Means

 Esempio: collocazione di nuove agenzie bancarie
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SSLL t_att_tot Tasso_AGR T_IND T_SERV Sport. BANC DEPOSITI/RESIDENTIIMPONIB/RESIDENTIIMPONIB/CONTRIB

BUSTO ARSIZIO1 45.9      0.49            55.6   43.9     62 24.0                        23.6                       26.4                     

GALLARATE 47.5      0.58            60.5   39.0     85 21.1                        13.8                       24.9                     

LUINO 44.1      2.04            47.9   50.1     14 12.1                        5.5                         20.4                     

SESTO CALENDE 44.7      1.55            56.2   42.3     42 15.9                        6.9                         23.9                     

VARESE1 45.4      1.07            49.6   49.4     104 23.7                        17.1                       27.0                     

MILANO1 45.7      0.65            48.9   50.5     35 23.6                        22.9                       28.0                     

VARESE2 45.6      1.29            58.8   39.9     4 12.9                        5.1                         25.4                     

BELLAGIO1 44.0      5.19            41.4   53.4     3 16.5                        7.2                         20.3                     

CAMPIONE D'ITALIA 43.9      3.97            35.0   61.0     7 17.0                        7.8                         20.5                     

COMO 45.9      1.13            49.8   49.0     207 23.0                        21.0                       26.1                     

MENAGGIO 42.5      4.43            45.9   49.6     18 17.1                        5.4                         20.1                     

PORLEZZA 42.8      3.78            47.0   49.2     7 15.4                        4.7                         13.0                     

MORBEGNO1 44.4      8.39            48.5   43.2     1 8.2                          3.0                         17.5                     

DESIO1 46.6      1.03            60.7   38.3     24 20.8                        16.6                       23.9                     

BORMIO 42.3      2.11            32.9   65.0     14 28.8                        32.1                       20.3                     

CHIAVENNA 42.3      4.71            45.8   49.5     11 16.5                        8.5                         19.6                     

CHIESA IN VALMALENCO 41.3      3.38            47.2   49.4     4 14.6                        7.6                         16.4                     

MORBEGNO2 42.3      4.10            48.5   47.4     23 19.8                        15.1                       21.2                     

SONDALO 42.7      3.24            38.9   57.8     7 13.4                        6.0                         21.0                     

SONDRIO 42.7      4.75            32.5   62.7     27 21.7                        23.7                       23.5                     

TIRANO 43.5      7.32            31.4   61.3     7 21.6                        15.2                       22.2                     

EDOLO1 44.4      2.51            20.9   76.6     2 25.5                        17.2                       17.1                     

BUSTO ARSIZIO2 46.3      0.76            56.2   43.0     103 18.9                        13.8                       25.3                     

LECCO1 44.2      1.57            54.9   43.5     2 12.4                        5.6                         26.1                     

DESIO2 46.9      0.55            53.6   45.9     172 18.9                        13.1                       24.4                     

MILANO2 46.5      0.46            34.8   64.7     1499 32.2                        65.0                       30.9                     

SANT'ANGELO LODIGIANO139.7      3.98            34.3   61.8     3 28.3                        12.7                       23.8                     



Introduzione al software KNIME Analytics Platform

▪ Cluster Analysis (non gerarchica) – 2/2  

 Nodo k-Means

 Dal confronto delle medie di ciascun segmento con le rispettive medie della popolazione risulta di 

particolare interesse il cluster che ha:

 - un valor medio degli occupati nell'agricoltura superiore al valor medio della popolazione 

 - un valor medio del numero di sportelli bancari inferiore al valor medio della popolazione

 - un valor medio dei depositi bancari per abitante superiore al valor medio della
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Variabile Statistica TOTALE Cluster1 Cluster2 Cluster3 Cluster4 Cluster5

Numero               88 12             20             12             28             16             

%             100 13             21             13             31             22             

DEPOSITI/RESIDENTI Media 21,1 22,4          23,0          25,5          16,9          21,9          

IMPONIB/CONTRIB Media 22,0 26,0          22,4          22,4          21,1          20,3          

IMPONIB/RESIDENTI Media 13,4 19,1          17,5          19,5          8,2            10,0          

SPORT. BANC Media 31,7 119,8        25,0          33,9          13,2          10,9          

T_IND Media 48,6 51,3          58,6          33,4          49,2          45,6          

T_SERV Media 44,7 47,2          35,9          61,3          46,3          39,4          

TASSO_AGR Media 6,7 1,5            5,5            5,3            4,5            15,0          

T_ATT_TOT Media 43,9 45,8          45,7          42,8          43,2          42,8          



Introduzione al software KNIME Analytics Platform

▪ Associazioni – 1/3

 

 Nodo Association Rule Learner

 Esempio: regole di associazioni prodotti del settore alimentari di un supermercato 
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Cliente Prodotto

1 [Zucchero,Uova,Latte,Farina,Lievito]

2 [Zucchero,Uova,Olio,Farina,Lievito]

3 [Uova,Olio,Latte,Farina]

4 [Zucchero,Uova,Latte,Lievito]

5 [Zucchero,Uova,Olio,Latte,Farina,Lievito]

6 [Zucchero,Uova,Farina]

7 [Zucchero,Uova,Olio,Farina,Lievito]

8 [Uova,Olio]

9 [Uova,Olio,Latte,Farina,Lievito]

10 [Zucchero,Uova,Latte,Farina]



Introduzione al software KNIME Analytics Platform

▪ Associazioni – 2/3

 

 Nodo Association Rule Learner

 Regola                                           Supporto     Confidenza            Lift  Leverage

 {Uova} => {Farina} 0,8  0,8 1,0 0

 {Farina} => {Uova} 0,8  1 1,0 0

 {Olio,Farina} => {Lievito} 0,4  0,8 1,3 0,1 

 {Zucchero,Uova} => {Farina} 0,6  0,86 1,07 0,04

 {Zucchero,Uova,Latte} => {Lievito} 0,3  0,75 1,25 0,06 

 Una regola credibile ha un valore alto di confidenza e di supporto e un valore di Lift maggiore di 1. 

Le regole che hanno un livello alto di confidenza, ma che hanno scarso supporto, devono essere 

interpretate con cautela, di nessuna utilità se hanno Lift = 1 o Leverage = 0.
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Introduzione al software KNIME Analytics Platform

▪ Associazioni – 3/3

 

 Nodo Association Rule Learner  

 

 Viene anche usato un nodo 

 R View per visualizzare 

 graficamente le associazioni 

 dei prodotti
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Introduzione al software KNIME Analytics Platform

▪ Trasformazione del testo in una matrice numerica  

 Con Knime si possono fare analisi su dati non strutturati con i nodi di Text 

Processing

• Pre-processing

• Trasformazione
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Introduzione al software KNIME Analytics Platform

▪ Applicazioni  

 Alla matrice termini/documenti si applicano tecniche di visualizzazione

• Parole rilevanti

 (Tag Clouds)
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Introduzione al software KNIME Analytics Platform

▪ Applicazioni  

 Alla matrice termini/documenti si applicano modelli di machine learning

• Clustering

- cluster_0 ("Gentilezza"): cordialità medici e personale

- cluster_1 ("Efficienza"): servizio veloce

- cluster_2 ("Efficacia"): trattamento e risultati
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Introduzione al software KNIME Analytics Platform

▪ Nodi di Scripting (R)

 In Knime si possono 

 integrare funzionalità

 del software R.

 Nodo R Snippet

 Permette l'esecuzione

 di uno script R da 

 parte di Knime.

 In questo esempio

 si testa la differenza 

 tra due proporzioni 

 (H0: n2/N2 > n1/N1)

 usando la funzione

 'prop.test'.
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 Vedi Appendice.
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Introduzione al software KNIME Analytics Platform

▪ Nodi di Scripting (R) 

 Nodo R Learner 

 Esegue uno script 

 R che fornisce in 

 uscita un modello.

 Nodo R Predictor

 Esegue uno script 

 R utilizzando il 

 modello creato dal 

 nodo R Learner per 

 effettuare previsioni.

 In questo esempio 

 viene utilizzato un 

 albero di decisione

 con la funzione rpart

 del package 'rpart'.
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Introduzione al software KNIME Analytics Platform

▪ Nodi Scripting (Python) 

 Nodo Python Learner 

 Esegue uno script 

 Python che fornisce in 

 uscita un modello.

 Nodo Python Predictor

 Esegue uno script 

 Python utilizzando il 

 modello creato dal 

 nodo Python Learner per 

 effettuare previsioni.

 In questo esempio 

 viene utilizzato il 

 package 'scikit-learn'.
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 Vedi Appendice.
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Introduzione al software KNIME Analytics Platform

▪ Nodi PMML

 Nodo PMML Writer

 Questo nodo scrive un modello

 in un file in conformità al PMML

 4.2 o in una posizione remota

 indicata con un URL.

 Nodo PMML Reader

 Legge un modello in formato 

 PMML

 

 Nodo PMML Predictor

 Effettua previsioni della classe di appartenenza su un nuovo insieme di dati
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Introduzione al software KNIME Analytics Platform

▪ Lingua nazionale 

 Permette di elaborare e visualizzare numeri e date/orari formattati secondo le 

convenzioni della lingua e dell'area geografica utilizzate.

• Aggiungere nel file Knime.ini la lingua e la regione desiderata

 Ad esempio, per la lingua italiana:

 -Duser.language=it

 -Duser.region=IT 
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Introduzione al software KNIME Analytics Platform

▪ Utilizzo della memoria 

 Opzioni

• Cambiare l’impostazione di -Xmx nel file Knime.ini 

 Ad esempio, per portarlo da 1 gigabyte a 4 gigabyte

 -Xmx1024m → -Xmx4g 

• Per elaborazioni onerose dal punto di vista

 computazionale si può scegliere dalla scheda

 Memory Policy di configurazione del nodo

 l'opzione “Keep all in memory“.

• In questa pagina si trovano ulteriori suggerimenti e consigli per ottimizzare  

l'esecuzione dei Workflow: 

https://www.knime.com/blog/optimizing-knime-workflows-for-performance
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Introduzione al software KNIME Analytics Platform

▪ Integrazione con R – 1/2

 Installazione in R del package Rserve

131

Appendice



Introduzione al software KNIME Analytics Platform

▪ Integrazione con R - 2/2

 Indicare nelle preferenze il percorso dell’installazione di R
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Introduzione al software KNIME Analytics Platform

▪ Integrazione con Python1 - 1/2

 1. Installare il package Anaconda: https://www.anaconda.com/download/

 2. Scaricare questo file di configurazione  ( lick tasto destro → Salva link con 

 nome…) in una cartella (p.e in C:\Temp)

 3. Aprire il prompt di Anaconda ed eseguire questo comando: 

   conda env create -f C:\Temp\py36_knime.yml

 4. Creare il file py36.bat in una cartella (p.e. C:\Users\<utente>\Anaconda3\Script)

  contenente queste righe: 

   @REM Adapt the folder in the PATH to your system

@SET PATH=C:\Users\Alfredo\Anaconda3;%PATH%

@CALL activate py36_knime || ECHO Activating python environment failed

@python %*
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1
 Queste istruzioni sono si trovano in https://docs.knime.com/2018-12/python_installation_guide/python_installation_guide.pdf 
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▪ Integrazione con Python - 2/2

 5. Indicare nelle preferenze il percorso 

  dell’installazione di  ython

  

 N.B. Non tutti i package di Python sono presenti nell'integrazione. Per poterne utilizzare altri 

bisogna installarli. Per esempio, per il package scikit-learn bisogna prima installarlo in Anaconda 

e poi in Knime. Aprire il prompt di Anaconda ed eseguire questi comandi: 

  conda install scikit-learn oppure pip install -U scikit-learn

  conda install -n py3_knime scikit-learn
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▪ Gestione del Workflow

 È possibile personalizzare il workflow

 aggiungere annotazioni

 allineare i nodi orizzontalmente/verticalmente

 
135

Appendice



Introduzione al software KNIME Analytics Platform

▪ Gestione del Workflow

 cambiare l'apparenza
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▪ Riferimenti 

 Software 

 Knime https://www.knime.org/

  R https://www.r-project.org/

  python https://www.python.org/

 Bibliografia

 Corsi di auto-apprendimento: https://www.knime.com/knime-self-paced-courses

 Libri https://www.knime.org/knimepress

 Forum

 Richieste di supporto https://forum.knime.com/
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▪ Esercizio
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▪ Soluzione



Introduzione al software KNIME Analytics Platform

L’azione va incontro all’insuccesso anche perché 

non di rado le conoscenze radunate con fervore di 

zelo non erano guidate da un filo conduttore. 

Non conosce chi cerca, bensì colui che sa cercare.

                              Luigi Einaudi

Contatti
alfredo.roccato(at)fastwebnet.it
www.alfredoroccato.it
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